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Introducing Microsoft InfoPath 2010
Welcome to Microsoft InfoPath 2010, a forms-creation and data-gathering tool that 
can help you streamline your business processes. InfoPath 2010 is well-suited for almost 
anyone who needs to design and deploy form solutions—including information workers, 
IT professionals, and developers. You can use InfoPath 2010 to design sophisticated forms 
that can quickly and accurately gather information that meet your organizational needs. 
And its deep integration with the Microsoft SharePoint platform opens up a new world of 
possibilities for your electronic form requirements. 

InfoPath empowers you to design and fill out electronic forms, such as expense reports, 
event registrations, and customer satisfaction surveys. And you can do this using com-
mon form controls that most users are familiar with, such as text boxes, drop-down list 
boxes, or hyperlinks. When entering data in an InfoPath 2010 form, users are presented 
with familiar, document-like features. For example, they can change fonts, check spelling, 
or insert images into certain fields. 

If you create your forms as browser-enabled form templates, users who don't have 
InfoPath installed on their computer can still work with the form in a browser. This lets 
you share business forms with a variety of users, including employees, customers, and 
vendors. 

You can design forms ranging from simple questionnaires to collect data from a small 
group to complex surveys that are integral components of a much bigger business 
process. InfoPath form templates can be used as a standalone tool, or you can design 
them to work with SharePoint lists, applications, databases, or web services. With this 
flexibility, designers in your organization can easily integrate the form data into exist-
ing business processes. If you utilize SharePoint Server 2010 and SharePoint Designer, 
InfoPath 2010 forms can be used as part of a fully automated business process. This can 
include workflows such as routing and notification based on information within the form. 
And the data that users enter in your InfoPath forms doesn't have to remain sealed inside 
that form forever; it can be reused in a variety of ways, especially when coupled with the 
SharePoint platform.
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New Features
Microsoft InfoPath 2010 is a major release and has several new features and capabilities 
compared with the 2003 and 2007 versions. We don’t specifically call out all new features 
in the book, but you will gain experience with most of the new capabilities as you wind 
your way through the various chapters and exercises. The list below includes some of the 
new feature highlights that are most relevant for this book:

●● The Microsoft Office Fluent Ribbon relieves you of the burden of hunting through 
menus, submenus, and dialog boxes. This new interface organizes all of the com-
mands that the majority of people use most often, making them quickly accessible 
from tabs at the top of the InfoPath window.

●● If you create your forms as browser-enabled form templates, users who don't have 
InfoPath installed on their computer can still work with the form in a browser. This 
lets you share business forms with a variety of users, including employees, custom-
ers, and vendors. Improved parity between InfoPath Filler 2010 forms and InfoPath 
browser forms in SharePoint Server 2010 ensures greater consistency across the 
spectrum of form users.

●● SharePoint Server 2010 offers a robust architecture for managing access to data 
connections and external systems. InfoPath 2010 has a specific form control—the 
External Item Picker—that works with Business Connectivity Services (BCS).

●● InfoPath 2010 includes a new installation option called InfoPath Filler. Filler presents 
people who are completing forms with a simple and easy-to-use interface. All of 
the functionality for designing forms is removed for those who just want to open a 
form and fill it out.

●● In SharePoint Server 2010, it’s easy to host your InfoPath forms on SharePoint pages 
by using the new InfoPath Form Web Part. You can simply add the InfoPath Form 
Web Part to a SharePoint 2010 Web Part page and point it to your form.

●● With InfoPath 2010, you can create forms with a click of a button, based on Share-
Point lists. If you have data in SharePoint lists, you can automatically generate a 
form with all of the SharePoint list column fields, and then customize it with the 
power of InfoPath.
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Let’s Get Started!
“When at last we are sure, you’ve been properly pilled, Then a few paper forms, 
Must be properly filled. So that you and your heirs, May be properly billed.”

Dr. Seuss

Tax forms, school forms, business forms, registration forms, order forms, medical 
forms—forms of all types and for all purposes. Forms, so ubiquitous, and yet so under 
appreciated. The decision to take on the challenge of authoring this book was driven 
in part by our passionate belief that InfoPath and SharePoint 2010 together represent 
a new opportunity to radically transform the experience of using forms from one of 
dread and tedium, to a much more positive experience. With this new software platform, 
the untapped potential for improving people’s everyday experience of building and 
using forms is vast. It was this potential for improvement that led us to share with you 
our knowledge and our passion for the world’s best forms creation and editing tool: 
InfoPath 2010. 

Hardware and Software Requirements
To complete the exercises in this book, you will need a Microsoft Windows–based com-
puter with InfoPath 2010 installed on it (either as part of Microsoft Office Professional or 
standalone InfoPath installation). 

The requirements to install InfoPath 2010 are:

●● Processor: 500 MHz or faster processor 

●● Memory: 256 MB RAM or more 

●● Hard disk: 2.0 GB available disk space 

●● Display: 1024 x 768 or higher resolution monitor 

●● Operating system, Windows XP (must have SP3) (32-bit), Windows 7, Windows 
Vista with SP1, Windows Server 2003 with SP2 and MSXML 6.0 (32-bit Office only), 
Windows Server 2008, or later, 32 or 64-bit OS.
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For many of the exercises in the book, you will also need access to a SharePoint 2010 
Server environment. Some exercises might require the Enterprise features of SharePoint 
such as InfoPath Forms Services. Ideally, you will have a SharePoint site where you have 
Site Owner permissions in order to effectively work through the exercises in the book. 
This will be necessary for creating the required forms libraries, workflows, data connec-
tions, and other SharePoint objects.

SharePoint Designer 2010 is also required for some exercises; a free download is available 
at http://sharepoint.microsoft.com/en-us/product/related-technologies/pages/sharepoint-
designer.aspx.

Office 365: InfoPath and SharePoint in the Cloud
If you do not have your own SharePoint environment, InfoPath 2010 supports the cre-
ation of forms in Microsoft Office 365, which is the online SharePoint service in the cloud. 
All versions of SharePoint Online have support for basic InfoPath integration, although 
the more advanced capabilities might require specific versions of Office 365. You can 
find more information on how to sign up for Office 365 at http://office365.microsoft.com. 
Chapter 2 has more information on how to decide which version of SharePoint best suits 
your needs.

You might notice some user interface differences in SharePoint Online versus an “on 
premises” installation of SharePoint in your company’s data center. Conceptually, the 
exercises in this book should work the same with Office 365 in the cloud as they do if you 
have a SharePoint Server sitting under your desk.

Who This Book Is For
This intended audience for this book is very broad—essentially, it is for any information 
worker that needs to build and use electronic forms that will be stored in SharePoint. 
Whether you are an IT professional, an attorney, a sales manager, administrative assistant, 
or a rocket scientist, this book can teach you the basics of building and using InfoPath 
2010 forms in a SharePoint 2010 environment. By the time you finish, you will be fully 
armed to create a very satisfying form experience for the consumers of your forms.

Because the target audience for InfoPath 2010 (and therefore, this book) is so wide-
ranging, we have intentionally set the bar low for required expertise to use this book. 
If you are a savvy Office and Windows user, that's a great start! For much of the book, 
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some existing knowledge of SharePoint Server will definitely be useful. However, even if 
you're not a SharePoint guru, most topics in this book should be within your grasp. You 
might need to become good friends with your SharePoint administrator; their help will 
be invaluable.

A note to IT professionals and software developers: if you don’t have much experience 
using InfoPath with SharePoint, you will likely find this book valuable. However, we want 
to be clear that you (the technical software professional) are not the primary reader we 
had in mind when structuring the content in this book. The mission of this book was not 
to be a comprehensive administrator or developer guide. That undertaking has already 
been covered by other excellent InfoPath and SharePoint 2010 books on the market.

How This Book is Organized
This book is organized around the idea of using InfoPath 2010 with SharePoint Server. The 
book does begin with a few chapters that are primarily focused on understanding Info-
Path itself; but by Chapter 4, the focus starts to turn to using InfoPath with SharePoint. 
That was our mantra for much of the book—highlight and focus on the areas of InfoPath 
that have a strong connection and relationship with SharePoint. Throughout the 14 chap-
ters that comprise this book, you will have an opportunity to design forms that integrate 
tightly with SharePoint in a variety of ways.

Chapter 1, “Introducing Microsoft InfoPath 2010,” explores the InfoPath interface, and 
helps you learn XML basics and to build a simple form. 

Chapter 2, “Form Requirements: Using a Decision Matrix,” helps you understand which 
types of InfoPath forms make sense for your requirements.

Chapter 3, “Form Design Basics: Working with InfoPath Layout, Controls, and Views,” 
shows you how to work with sample forms to help you understand different ways to put 
the basic form components together.

Chapter 4, “Working with SharePoint List Forms,” demonstrates how to use InfoPath to 
customize SharePoint 2010 list forms.

Chapter 5, “Adding Logic and Rules to Forms,” explores the capability of InfoPath to add 
business logic and data validation to forms, without code.

Chapter 6, “Publishing and Submitting Form Data,” helps you to experience the various 
options for publishing your forms to SharePoint.
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Chapter 7, “Receiving Data from SharePoint Lists and Business Connectivity Services,” 
presents information on how to retrieve data in to your forms from SharePoint data 
sources.

Chapter 8, “Using the InfoPath Form Web Part,” leads you through the process of display-
ing your form in a SharePoint Web Part.

Chapter 9, “Working with the SharePoint User Profile Web Service,” teaches you how to 
integrate information about SharePoint users in to your forms by adding web service 
data connections.

Chapter 10, “InfoPath Integration with SharePoint Designer Workflows,” helps you to 
understand how SharePoint Designer and InfoPath work together to build custom work-
flow forms.

Chapter 11, “Building an Approval Process,” shows you how to add workflows and rout-
ing to your forms. 

Chapter 12, “Managing and Monitoring InfoPath Forms Services,” leads you through 
working with a variety of administration tools to manage browser-based forms.

Chapter 13, “SharePoint Views and Dashboards,” shows you how to take advantage of 
SharePoint’s power to build customized views and dashboards that contain data from 
your forms. 

Chapter 14, “Advanced Options,” explores various tips and tricks for integrating advanced 
form requirements.

Darvish’s Acknowledgments
Contrary to popular belief, an author’s primary motivation for writing a book such as this 
is not always career advancement, money, or fame. In my particular case, my four amazing 
children have been the underlying motivation for most of the good things I do in my life, 
and this book is no exception. It is of great importance to me that their eyes are wide open 
to what’s possible in life with enough dedication and hard work. It is my hope that in some 
small way, seeing their Dad’s name on a book will help to expand their mind’s boundaries 
as they grow and explore their own paths. Hannah, Sydney, Devin, and Zoe—thank you 
for your patience and understanding during the several months that it took Dad to work 
on this project. I love you all very much. Next summer, we’ll stay at the lake a few days 
longer...
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Thanks to the InfoPath and SharePoint team members at Microsoft who supported me 
in various ways through this effort. During the process of writing this book, I emailed, 
disturbed, and interrogated many of them quite often. I’ve had the pleasure of getting to 
know many team members over the last several years and look forward to continuing 
to work with them. Particular thanks are extended to the following folks whose contribu-
tions, example forms, technical guidance, and support I could not have done without:

●● Roberto Taboada

●● Peter Allenspach

●● Laura Harrington

●● Daniel Witriol

●● Philip Newman

●● Keenan Newton

●● Nick Dallett (now with Expedia)

To the local team members with whom I work every day at Microsoft in the North 
Central District, thank you all for your support and understanding while I undertook this 
authoring challenge. 

Thanks to the editorial teams at O’Reilly Media for their guidance and support through-
out the development of this book. A special thanks to our editor Kenyon Brown and 
copyeditor Richard Carey. It’s difficult to imagine two more collaborative, professional, 
and seasoned professionals. They’ve been there when I needed support—and when I 
needed a kick in the pants. 

Lastly, thank you to my amazing coauthor Laura Rogers. Words can’t fully capture what 
it’s like to collaborate so closely with someone like Laura over the course of several 
months. She’s been brilliant, supportive, hard-working, and frankly I just could not have 
done this project without her. Thank you Laura: you rock!

Darvish Shadravan
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Laura’s Acknowledgments
For about eight years, InfoPath has been a huge part of my daily work. I thoroughly 
enjoy working with InfoPath and SharePoint. Thus, writing this book has been an enjoy-
able and fulfilling experience. It feels great to share the technology with newcomers so 
that they can create their own custom business solutions, without code.

For my acknowledgments, I’m going all the way back to 1982 in south Louisiana. Thanks 
to my elementary school teacher, Mrs. Susan Burge. There were seven of us in her gifted 
class 4 hours of the day, for three years. The class was so special and amazing. That unique 
learning environment (in a public school) has been a huge advantage. We had to work 
hard and do spelling and grammar drills every single day, but we also had many frequent 
field trips to places like nearby New Orleans. It was truly enriching. Now that my children 
are getting to be that same age, I think about those days, and try to pass some of those 
learning experiences on to them. I want them to love reading and writing just like their 
Mommy does.

Charlotte and Kristen, you are the most sweet and beautiful daughters I could ever ask 
for. Thanks to my husband, Chris, and my girls for being supportive and patient with me 
when weekend writing was required. 

Don’t tell him, but I have been a big fan of Darvish Shadravan for several years. I have 
seen him speak at several conferences, and always took prolific notes in his sessions. 
When Darvish presented me with this chance to coauthor this book with him, how could 
I say no? It has been fun and challenging collaborating on this project. We didn’t just go 
off separately and write individual chapters about incongruent topics. A lot of time was 
spent working on the outline, the order of things, and we made sure to get all of the im-
portant points across in the book. We wanted to teach the readers as much as possible.

Also, thank you to Kenyon Brown and the team at O’Reilly Media for all of your hard 
work and guidance. You have all been extremely knowledgeable and proficient in our 
collaboration along the way. Thank you for your patience and professionalism.

Laura Rogers
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Modifying the Display of the Ribbon
The goal of the Office working environment is to make working with Office documents, 
including Microsoft Word documents, Microsoft Excel workbooks, Microsoft PowerPoint 
presentations, Microsoft Outlook email messages, and Microsoft Access database tables, 
as intuitive as possible. You interact with an Office document and its contents by issuing 
commands to the program in which the document is open. All Office 2010 programs 
organize commands on a horizontal bar called the ribbon, which appears across the top 
of each program window, whether or not there is an active document.

Ribbon tabs Ribbon groups

Commands are organized on task-specific tabs of the ribbon, and in feature-specific 
groups on each tab. Commands generally take the form of buttons and lists. Some 
appear in galleries. Some groups have related dialog boxes or task panes that contain 
additional commands. 

Throughout this book, we discuss the commands and ribbon elements associated with 
the program feature being discussed. In this topic, we discuss the general appearance of 
the ribbon, things that affect its appearance, and methods for locating commands that 
aren’t visible on compact views of the ribbon.

Tip  Some older commands no longer appear on the ribbon, but they are still available in the 
program. You can make these commands available by adding them to the Quick Access Toolbar. 

Dynamic Ribbon Elements
The ribbon is dynamic, which means that the appearance of commands on the ribbon 
changes as the width of the ribbon changes. A command might be displayed on the 
ribbon in the form of a large button, a small button, a small labeled button, or a list 
entry. As the width of the ribbon decreases, the size, shape, and presence of buttons on 
the ribbon adapt to the available space.
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For example, when sufficient horizontal space is available, the buttons on the Review tab 
of the Word program window are spread out and you’re able to see more of the com-
mands available in each group.

Drop-down lists Large button Gallery Small labeled buttons

If you decrease the width of the ribbon, small button labels disappear and entire groups 
of buttons hide under one button that represents the group. Click the group button to 
display a list of the commands available in that group.

Group button Small unlabeled buttons

When the window becomes too narrow to display all the groups, a scroll arrow appears 
at its right end. Click the scroll arrow to display hidden groups.

Scroll arrow
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Changing the Width of the Ribbon
The width of the ribbon is dependent on the available horizontal space, which depends 
on these three factors:

●● The width of the program window  Maximizing the program window provides 
the most space for ribbon elements. You can resize the program window by clicking 
the button in its upper-right corner or by dragging the border of a non-maximized 
window.

Tip  On a computer running Windows 7, you can maximize the program window by 
dragging its title bar to the top of the screen.

●● Your screen resolution  Screen resolution is the size of your screen display 
expressed as pixels wide × pixels high. The greater the screen resolution, the 
greater the amount of information that will fit on one screen. Your screen resolution 
options are dependent on your monitor. At the time of writing, possible screen 
resolutions range from 800 × 600 to 2048 × 1152. In the case of the ribbon, the 
greater the number of pixels wide (the first number), the greater the number of 
buttons that can be shown on the ribbon, and the larger those buttons can be.

On a computer running Windows 7, you can change your screen resolution in the 
Screen Resolution window of the Control Panel. You set the resolution by dragging 
the pointer on the slider.

●● The density of your screen display  You might not be aware that you can change 
the magnification of everything that appears on your screen by changing the screen 
magnification setting in Windows. Setting your screen magnification to 125% makes 
text and user interface elements larger on screen. This increases the legibility of 
information, but it also means that less fits onto each screen.
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On a computer running Windows 7, you can change the screen magnification in 
the Display window of the Control Panel. You can choose one of the standard dis-
play magnification options or create another by setting a custom text size.

The screen magnification is directly related to the density of the text elements on 
screen, which is expressed in dots per inch (dpi) or points per inch (ppi). (The terms 
are interchangeable, and in fact are both used in the Windows dialog box in which 
you change the setting.) The greater the dpi, the larger the text and user interface 
elements appear on screen. By default, Windows displays text and screen elements 
at 96 dpi. Choosing the Medium - 125% display setting changes the dpi of text and 
screen elements to 120 dpi. You can choose a custom setting of up to 500% magni-
fication, or 480 dpi, in the Custom DPI Setting dialog box. The list allows you to 
choose a magnification of up to 200%.You can choose a greater magnification by 
dragging across the ruler from left to right.
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See Also  For more information about display settings, refer to Windows 7 Step by Step 
(2009, Microsoft Press), Windows Vista Step by Step (2006, Microsoft Press), or Windows XP 
Step by Step (2002, Microsoft Press), by Joan Lambert Preppernau and Joyce Cox.

Adapting Exercise Steps
The screen images shown in the exercises in this book were captured at a screen resolu-
tion of 1024 × 768, at 100% magnification, and the default text size (96 dpi). If any of 
your settings are different, the ribbon on your screen might not look the same as the 
one depicted in the book. For example, you might see more or fewer buttons in each 
of the groups, the buttons you see might be represented by larger or smaller icons than 
those shown, or the group might be represented by a button that you click to display the 
group’s commands.

When we instruct you to give a command from the ribbon in an exercise, we do it in this 
format:

●● On the Insert tab, in the Illustrations group, click the Chart button.

●● If the command is in a list, we give the instruction in this format:

●● On the Page Layout tab, in the Page Setup group, click the Breaks button, and 
then in the list, click Page.

The first time we instruct you to click a specific button in each exercise, we display an 
image of the button in the page margin to the left of the exercise step.

If differences between your display settings and ours cause a button on your screen to 
look different from the one depicted in the book, you can easily adapt the steps to locate 
the command. First, click the specified tab. Then locate the specified group. If a group 
has been collapsed into a group list or group button, click the list or button to display 
the group’s commands. Finally, look for a button that features the same icon in a larger 
or smaller size than that shown in the book. If necessary, point to buttons in the group to 
display their names in ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you 
read and work through the exercises in the book.
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Features and Conventions of 
This Book

This book has been designed to lead you step by step through all the tasks you’re most 
likely to want to perform in Microsoft InfoPath 2010. If you start at the beginning and 
work your way through all the exercises, you will gain enough proficiency to be able to 
create and work with most InfoPath plus SharePoint form scenarios. However, each topic 
is self-contained. If you have completed all the exercises and later need help remember-
ing how to perform a procedure, the following features of this book will help you locate 
specific information:

●● Detailed table of contents  Search the listing of the topics and sidebars within 
each chapter.

●● Chapter thumb tabs  You can use these to easily locate the beginning of the 
chapter you want.

●● Topic-specific running heads  Within a chapter, quickly locate the topic you 
want by looking at the running heads at the top of odd-numbered pages.

●● Glossary  Use this to look up the meaning of a word or the definition of a concept.

●● Keyboard Shortcuts  If you prefer to work from the keyboard rather than with a 
mouse, you can find all the shortcuts in one place.

●● Detailed index  Look up specific tasks and features in the index, which has been 
carefully crafted with the reader in mind.

You can save time when reading this book by understanding how the Step by Step series 
shows exercise instructions, keys to press, buttons to click, and other information.

Convention Meaning

   SET UP
This paragraph preceding a step-by-step exercise indicates the prac-
tice files that you will use when working through the exercise. It also 
indicates any requirements you should address or actions you should 
take before beginning the exercise.

   CLEAN UP This paragraph following a step-by-step exercise provides instructions 
for saving and closing open files or programs before moving on to 
another topic. It also suggests ways to reverse any changes you made 
to your computer while working through the exercise.
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Convention Meaning
1.
2.

Numbered steps guide you through hands-on exercises in each topic, 
as well as procedures in sidebars and expository text.

See Also This paragraph directs you to more information about a topic in this 
book or elsewhere.

Troubleshooting This paragraph alerts you to a common problem and provides guid-
ance for fixing it.

Tip This paragraph provides a helpful hint or shortcut that makes working 
through a task easier.

Important This paragraph points out information that you need to know to 
complete a procedure.

Keyboard 
Shortcut

This paragraph provides information about an available keyboard 
shortcut for the preceding task.

Ctrl+B A plus sign (+) between two keys means that you must press those 
keys at the same time. For example, “Press Ctrl+B” means that you 
should hold down the Ctrl key while you press the B key.
Pictures of buttons appear in the margin the first time the button is 
used in a chapter.

Bold In exercises that begin with SET UP information, bold type displays 
text that you should type; the names of program elements, such as 
buttons, commands, windows, and dialog boxes; and files, folders, or 
text that you interact with in the steps.
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Downloading the Practice Files  
and eBook

Before you can complete the exercises in this book, you need to copy the book’s practice 
files to your computer. These practice files, and other information, can be downloaded 
from here:

http://www.microsoftpressstore.com/title/9780735662063

Display the detail page in your web browser and follow the instructions for downloading 
the files.

Important  The Microsoft InfoPath 2010 program is not available from this website. You should 
purchase and install that program before using this book.

The following table lists the practice files for this book.

Chapter File
Chapter 3, Form Design Basics: Working with 
InfoPath Layout, Controls, and Views

Raw Flight Delay Form.xsn
Flight Delay Form Post Exercise 1.xsn
Flight Delay Form Post Exercise 2.xsn
Flight Delay Form Post Exercise 3.xsn
Flight Delay Form Post Exercise 4.xsn
Blue Yonder Header.bmp

Chapter 5, Adding Logic and Rules to Forms No rules procurement.xsn
Completed Procurement.xsn
Blue Yonder Records Management  
SharePoint Site Request Form.xsn
Completed - Blue Yonder Records  
Management SharePoint Site Request 
Form.xsn

Chapter 7, Receiving Data from SharePoint Lists 
and Business Connectivity Services

Flight Delay Form.xsn
UDC Form.xsn
External Item Picker Example.xsn

Chapter 11, Building an Approval Process ContosoReimbursementForm.xsn
ContosoReimbursementFinal.xsn

Chapter 13, SharePoint Views and Dashboards Helpdesk Requests.XSN
NewFormButton.png

Chapter 14, Advanced Options Translate example.xsn

http://www.microsoftpressstore.com/title/9780735662063
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Your Companion eBook
The eBook edition of this book allows you to:

●● Search the full text

●● Print

●● Copy and paste

To download your eBook, please see the instruction page at the back of this book.
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Getting Support and Giving Feedback

Errata
We’ve made every effort to ensure the accuracy of this book and its companion content. 
Any errors that have been reported since this book was published are listed on our 
Microsoft Press site: 

http://www.microsoftpressstore.com/title/ 9780735662063

If you find an error that is not already listed, you can report it to us through the same 
page.

If you need additional support, email Microsoft Press Book Support at mspinput@
microsoft.com.

Please note that product support for Microsoft software is not offered through the 
addresses above.

Getting Help with Microsoft InfoPath 2010
If your question is about Microsoft InfoPath, and not about the content of this Microsoft 
Press book, your first recourse is the Microsoft InfoPath Help system. You can find gen-
eral or specific Help information in a couple of ways:

●● In the Microsoft InfoPath window, you can click the Help button (labeled with a 
question mark) located in the upper-right corner of the window to display the 
Microsoft InfoPath Help window.

●● On the ribbon, you can click the File tab to access the Help button.

If your question is about Microsoft InfoPath or another Microsoft software product and 
you cannot find the answer in the product’s Help system, please search the appropriate 
product solution center or the Microsoft Knowledge Base at:

http://support.microsoft.com

In the United States, Microsoft software product support issues not covered by the 
Microsoft Knowledge Base are addressed by Microsoft Product Support Services. 
Location-specific software support options are available from:

http://support.microsoft.com/gp/selfoverview

http://www.microsoftpressstore.com/title/ 9780735662063
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We Want to Hear from You
At Microsoft Press, your satisfaction is our top priority, and your feedback our most valu-
able asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in 
advance for your input!

Stay in Touch
Let’s keep the conversation going! We’re on Twitter:

http://twitter.com/MicrosoftPress
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	 1	 Introducing Microsoft 
InfoPath 2010

In this chapter, you will learn how to:
4	 Enumerate the benefits of using InfoPath 2010 forms with Microsoft 

SharePoint 2010
4	 Use the Microsoft Office Backstage functions to create a new InfoPath form
4	 Navigate the InfoPath interface
4	 Create a basic XML file and integrate it into an InfoPath form

When speaking about Microsoft InfoPath at technology conferences, I often open the 
discussion by posing the following question to the audience: who or what is it that “runs 
the show” here on planet Earth? The responses include many entertaining and thought-
ful comments, such as "money," "The Illuminati," “the military,” and my personal favorite, 
“Bill Gates.” While I acknowledge all of these as good guesses, the premise I submit to 
the audience is that forms run the world. Imagine modern life without forms, both paper 
and digital—it’s not possible! Everything that is known and recorded about you, from 
your birth city to your magazine subscriptions, to your preference of aisle or window 
seats—yes, all this information was entered in a form at some point in time. Forms of all 
sizes, shapes, colors, and styles have positively flourished! 

We have become so accustomed to consuming information in modern life that the expe-
rience of creating and capturing that information is often overlooked. Forms now perme-
ate daily life so deeply that we often don’t consciously realize the extent to which they 
have proliferated, and the extent to which we have come to rely on them. And let’s be 
honest: most of these forms could be improved to make them more user friendly, more 
efficient, and more capable of providing long-term business value with all that data 
that’s being collected. 
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If you are reading this book, we can safely assume that you have a mission of building, 
deploying, and using digital forms on the SharePoint 2010 platform. Accordingly, the 
mission of this book is to help you understand how to create business forms that provide 
a pleasant, reliable, and intuitive experience for your users and customers. 

And just how exactly shall you endeavor to accomplish this lofty objective? This is where 
Microsoft InfoPath 2010 will assist with your mission. While it is true that e-forms have 
been around for a couple decades, it is only now that we are seeing a complete platform 
capable of truly revolutionizing the way data is captured, stored, reported, and utilized 
for collaboration. Armed with this book, we will take you, the business forms designer, 
on a journey of understanding so that you can make the most of this amazing set of 
software tools now at your finger tips.

Practice Files  No practice files are required to complete the exercises in this chapter.

Benefits of Using InfoPath 2010 with 
SharePoint 2010

InfoPath is now in its third major version and has matured into a product capable of de-
signing forms for business, schools, and government agencies of all sizes. It is suitable for 
scenarios as simple as a small business that needs basic information tracking, all the way 
up to enterprises with many thousands of users entering data simultaneously worldwide. 
Many of the core concepts of InfoPath have not changed over the years. It’s still a flex-
ible, powerful, easy-to-use, XML-based forms editor. But what has changed is the level of 
integration InfoPath 2010 has with the Microsoft SharePoint 2010 platform. 

SharePoint 2010 is a perfect companion application server platform on which to 
host InfoPath forms because of the complementary set of features SharePoint offers. 
SharePoint 2010 has a broad set of capabilities for businesses, including collaboration, 
search, content management, reporting, workflows, and forms. Almost all of the major 
functionality areas in SharePoint 2010 can be integrated with InfoPath forms and the 
data contained therein. While you can bring so many value-added solutions to your 
users with InfoPath, it is important to use your imagination and think beyond “just a 
form.” This book will help spur your thinking as you complete the comprehensive exer-
cises and form-building scenarios.

SharePoint libraries, specifically form libraries, are well suited for storing and manag-
ing InfoPath forms. And because form libraries are fundamentally just another type 
of SharePoint list, you have an abundance of SharePoint capabilities such as workflow, 
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columns, and user-defined views to enhance the interface and functionality of your form 
solutions. We will review publishing InfoPath to SharePoint form libraries in depth later in 
the book.

SharePoint 2010 also offers a very robust workflow platform that your forms can easily 
use. The possibilities are limited only by your imagination—approvals, routing, and al-
most every business process require some level of workflow, and fortunately, SharePoint 
2010 has a very capable workflow framework. Several of the examples in this book will 
contain workflow integration. Chapter 11, “Building an Approval Process,” focuses pri-
marily on understanding how to integrate a common business workflow scenario with 
InfoPath forms.

Reporting and Business Intelligence capabilities in SharePoint 2010 help you extract the 
data from your forms and present it to business users in a format from which they can 
immediately derive value. The InfoPath data can be “promoted” to populate SharePoint 
columns, and thus numerous opportunities exist to reuse the information, including 
Key Performance Indicators (KPIs), Business Intelligence dashboards/reports, and more. 
We will take a deeper look at integration of form data into reports and dashboards in 
Chapter 13, “SharePoint Views and Dashboards.”

Often, forms are not islands of data by themselves; they need integration of data from 
other systems to be used in drop-down fields, text fields, and other controls. With 
SharePoint 2010, we have multiple ways to meet this requirement. InfoPath itself sup-
ports data connections to many data source types, including web services, XML files, and 
databases. This will be covered in depth in Chapter 7, “Receiving Data from SharePoint 
Lists and Business Connectivity Services,” and Chapter 9, “Working with the SharePoint 
User Profile Web Service.” We now also have Business Connectivity Services (BCS) in 
SharePoint 2010 with which you can easily create External lists of data in SharePoint that 
can be used in your forms. These External lists of business data can provide access to 
a wide variety of information that is stored in your existing systems (for example, CRM, 
product databases, Human Resources). The underlying concept of the BCS in SharePoint 
is a powerful one: easily make connections to business data. This will help you build 
InfoPath forms that do not require the creation of redundant data sets for use in com-
mon form controls such as drop-down menus. Imagine a standard form that allows your 
users to order widgets that they will use during the course of their daily work. Does it 
make sense to re-key this product data in a drop-down field in the order form, or does it 
make more sense to connect InfoPath to your existing product/ordering database? 

The list of capabilities that your forms can take advantage of in SharePoint 2010 goes on 
and on: enterprise search, a variety of useful Web Parts, portal pages, extranets, enter-
prise content management, and much more.



4    Chapter 1  Introducing Microsoft InfoPath 2010

This book is unique in that its focus is the use of InfoPath 2010 in a SharePoint environ-
ment. While InfoPath 2010 can be published to a variety of locations, including email, 
network shares, or your desktop, this book is primarily focused on forms that are de-
signed for use in conjunction with SharePoint 2010.

New Features of InfoPath 2010
For those of you upgrading from previous versions of InfoPath, you will immediately no-
tice many significant improvements in this version. The first thing that might strike you 
is that InfoPath 2010 is the first version of InfoPath to receive the new Microsoft Office 
Fluent interface. This new user interface includes the ribbon and the Backstage view. 
These are major advancements toward improving the usability of InfoPath and providing 
productivity gains for both the designers and the form users.

The Office ribbon provides a series of tabs that are “intelligent” in the respect that they 
are context sensitive. In other words, they present buttons to you organized by activity 
and particular tasks. For example, when you create a new form, choose the Insert tab on 
the ribbon, and then click Custom Table, you are automatically taken to the Table Layout 
tab so that you can refine your table. 

In the 2007 version of InfoPath, users would consume forms in two primary ways: 
either in InfoPath on their desktops or in a browser if the form had been published to 
SharePoint Form Services. With InfoPath 2010, you have a third option. The InfoPath 
desktop client now consists of two parts: InfoPath Designer, which provides the full de-
sign experience, and InfoPath Filler. Filler is a new InfoPath desktop installation option 
for users who need to fill in and submit forms but do not need to modify or create new 
form templates. Chapter 2, “Form Requirements: Using a Decision Matrix,” has in-depth 
descriptions of the three options and the particular use-cases that are most appropriate 
for each one.



	 New Features of InfoPath 2010    5

One very common request in the past from SharePoint customers was for an easier 
way to customize the default input form for a SharePoint list. In previous versions of 
SharePoint, customizing a list form required significant expertise and was not a straight-
forward process. But now, with InfoPath 2010, you can create attractive input forms on 
SharePoint lists with the click of a button. If you have existing data in SharePoint lists, 
you can quickly generate a new input form with all of the SharePoint column data. 
We have exercises that will cover this capability in depth in Chapter 4, “Working with 
SharePoint List Forms.”
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If you decide to utilize SharePoint Form Services to deliver your forms for consumption 
in web browsers, InfoPath 2010 includes enhanced support for browser-based forms. 
Web browser forms in 2010 provide a more consistent and richer, user experience, nearly 
matching the experience of using the InfoPath client application. Controls and function-
ality now supported in browser forms include the following:

●● Date and time controls for adding rich date and time fields

●● Bulleted, numbered, and plain lists

●● Multiple selection list box, which is a control with which users can select multiple 
items within a single field 

●● Combo boxes for when you need to let users either type in their own text or choose 
from a list of pre-populated items in a drop-down field

●● Hyperlink capabilities

●● Choice of group and section; users can decide whether or not they need that par-
ticular section of the form

●● Person/Group pickers for adding a control to your forms with which users can select 
user names from a SharePoint user list 

●● Filtering data that is displayed in controls that can now be filtered in web browser 
forms, limiting the number of items displayed to a user in list boxes, drop-down list 
boxes, combo boxes, repeating tables, and repeating sections

●● Picture buttons for when you prefer a button that is an image of your choice.

One of the primary tools for adding logic and formatting to a form is via the use of rules. 
Common examples of the types of things you can use rules for are as follows:

●● Automatically updating the contents of a field based on a selection or choice a user 
made somewhere else in the form

●● Hiding controls/fields until a user takes some specific action in the form

●● Dynamically changing the formatting of text based on input or selections the user 
has made in the form

●● Showing a pop-up message based on actions the user has taken or in accordance 
with specific data they have input

InfoPath 2010 has a much easier way to work with rules, validation, and conditional for-
matting: it’s called the Rules task pane. 
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Along with the Rules pane, we have the very helpful new Add Rules (also called Quick 
Rules) button on the ribbon, with which you can very quickly add common, pre-built 
logic and validation rules to your form without code. The new rules features make it so 
easy to add data validation and conditional formatting that you will have no problem 
designing forms that easily guide your users through the process of filling them out! 
Rules will be covered in depth in Chapter 5, “Adding Logic and Rules to Forms.”
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InfoPath 2010 makes laying out an attractive and visually pleasing form easier than ever. 
You can insert one of the pre-built page layouts from the Page Design tab on the rib-
bon to give your form structure. And then you can easily apply a theme to provide your 
form professional-looking colors and styles. With all the new layout tools in InfoPath 
2010, even novice InfoPath users can create forms that are highly functional and visually 
pleasing.

The Backstage view is a major enhancement in the way you perform common tasks 
with your forms, such as printing, publishing, and setting form options. To access the 
Backstage view, simply click the File tab on the ribbon. In Backstage view, you will find a 
variety of very useful features and tools all in one place, including the following:

●● You can save, open, or close forms all in one convenient place. 

●● You can use the Info tab to work with a variety of configurable properties of your 
form. For example, you can use the Info tab to publish your form, define how it 
will be submitted by your users, and scan for potential problems with the Design 
Checker. 
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●● You can use the Form Options button to configure a number of important settings 
for your form, including offline support, compatibility of your form with browsers, 
and versioning. 

●● You can use the Recent tab to see a list of forms that you have worked with 
recently.

●● On the New tab, you can initiate the creation of a variety of form templates, includ-
ing the primary templates we are concerned with in this book—the SharePoint form 
library and list templates. 
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●● Using the Print tab, you can handle all printing tasks, including the ability to 
determine which printer you want to print your finished form to. It also provides a 
very handy print preview feature so that you can see just what your form will look 
like when it is on paper. With this WYSIWYG (“what you see is what you get”) print 
preview, there are no more excuses for wasted printer paper.

●● The Publish tab is the area in the Backstage view where you decide the location 
in which to publish your form template. This will determine where your users will 
access and save their copies of the form later. While you have a variety of options 
for where to publish your form templates, the primary focus of this book is on 
SharePoint. 
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How InfoPath Works
InfoPath is unique in its ability to provide forms design capabilities that include sophis-
ticated logic rules, conditional formatting, and data validation to information workers 
who might not be programmers. To benefit from these capabilities previously would 
have required a great deal of technical expertise. A large part of the power of InfoPath 
is that the file format of the forms is eXtensible Markup Language, or XML, which pro-
vides many inherent benefits in terms of flexibility, power, and standardization. However, 
as the forms designer, you are not required to know too much about XML, XSD, XSLT, 
and all the other technical details behind the scenes. Of course, we’d still encourage you 
to gain as much knowledge as possible; it will increase your skills and confidence with 
InfoPath.
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The user interface of InfoPath is very similar to the other Microsoft Office 2010 products. 
If you are familiar with Microsoft Word, Microsoft Excel, or Microsoft Access, you will feel 
right at home in InfoPath 2010. It is a hybrid tool that combines the best of a traditional 
document editing experience with the structured data-capture capabilities of a forms 
package, thus providing end users with the ability to create valid XML documents. Below 
is a sample InfoPath form that is used for a procurement application. We’ll revisit this 
form later in the book.

InfoPath is available either by itself or as part of the Office 2010 suite. The forms can be 
published to a variety of locations, including email, file shares, and SharePoint. One very 
powerful InfoPath capability is the ability to publish the forms in such a way that the 
form consumer can either use InfoPath on her desktop or via her browser, using InfoPath 
Forms Services. This will enable you to target different types of forms to different types 
of use-case scenarios based on your specific requirements. We will cover these options 
in great detail in Chapter 2 and provide all the necessary detail for you to make an in-
formed decision.
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When you create a new form, you are actually creating an InfoPath template. The tem-
plate is saved with the .xsn file extension. After you publish your template to a location 
that is accessible by your users, they can create forms that are based on your template, 
but each instance they create and save will be saved with an .xml file extension. So to 
recap, you use InfoPath in Design mode to create .xsn templates, which are published 
to locations where your users can generate new form instances (.xml files), based on 
your template. You will learn more about designing forms in later chapters. For now, it 
is important you understand a bit about XML and then the difference between a form 
template and a form instance. 

Quick Tour of the Backstage View in InfoPath 2010
In the following exercise, you will work with the InfoPath Designer and become familiar 
with the ribbon, controls, themes, and the Backstage view.

SET UP  Open your Windows Start menu.

	 1.	 Open the InfoPath Designer. 
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	 2.	 In the Backstage view, on the New tab, double-click Blank Form in the Popular 
Templates section.

	 3.	 At the top of the form, click Click to add title.

	 4.	 Type in Products.

	 5.	 On the ribbon, click the Page Design tab.

	 6.	 In the Themes area, click the drop-down arrow. 

	 7.	 Select Industrial - Graham from the Industrial themes. 

	 8.	 On the ribbon, click the Home tab.

	 9.	 Place your cursor just to the right of the Products title, and then press Enter so 
that your cursor is active on the line below the title.

	 10.	 From the Controls area on the ribbon, select the Date Picker. A single click should 
add it to your form in the location where your cursor was positioned. 

	 11.	 Still on the Home tab of the ribbon, select the Preview button on the far right.

	 12.	 After your preview opens up, select a date from the date picker so that you can see 
how this control works. 
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	 13.	 Click Close Preview.

	 14.	 On the ribbon, click the File tab.

	 15.	 Click Save As, and then name the form Products. Save it in your Documents 
folder on your local computer.

After you’ve completed the preceding steps, you can leave the form open because you 
will use it in the next exercise.

CLEAN UP  Leave InfoPath Designer open if you are continuing to the next section of 
this chapter. Otherwise, close it.
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XML 101
XML is perhaps the single most powerful method of storing and sharing structured data 
to come along since the advent of digital computing. And fortunately, the native tongue 
of InfoPath is XML. The fact that the file format InfoPath uses to store and manage data 
is XML provides an amazing amount of power in an easy-to-use tool. InfoPath does an 
exceptional job of providing everyday business users of Microsoft Office with the ability 
to take advantage of the plentiful benefits of XML, while hiding much of the complex-
ity. You do not need to become an expert in XML to create powerful forms, but to have 
a basic understanding of what XML is and how it works seems a reasonable goal if you 
want to take full advantage of InfoPath’s power. 

InfoPath uses XML as its primary file/output format. Behind the scenes, when a user cre-
ates an InfoPath form, they are actually creating an XML Document and an associated 
XML Schema. In addition, InfoPath can use XML data files and XML web services as “data 
connections” in your forms. So if your business already has other XML data sources, rest 
assured that you can take advantage of that data in InfoPath. For example, as shown in 
the following illustration, you could use a simple XML file containing product informa-
tion to populate a field in your InfoPath form, such as a table or drop-down menu. In 
fact, you will create this XML file later in this chapter and build a simple form with a table 
based on the data in it.
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You’ll notice in the preceding screenshot that although the structure might appear 
strange to you, the data in the XML file is “human readable.” This is one of the many 
great benefits of XML. In this regard, XML is similar to HTML, with a key difference being 
that XML has a much more defined structure. And as you can see, if you need to open 
and work with the raw data in the XML file, you can use simple tools such as Microsoft 
Notepad.

A user who edits an InfoPath form is actually editing an XML document, although the 
InfoPath interface strips away the complexity. InfoPath also takes advantage of another 
industry standard technology when editing a form: Extensible Style Sheet Language 
(XSLT). XSLT style sheets “sit in front of” the underlying XML and transform it into the 
rich and easy-to-use forms that InfoPath can produce.

InfoPath uses XML standards to provide end users with a flexible yet structured XML 
editing software tool for data gathering. It provides similar levels of power and flexibility 
as more traditional forms created by programmers with complex tools, but InfoPath pro-
vides the ease of use of the family of Office products.
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Creating the Products.xml File
In the following exercise, you will create a small XML data file.

SET UP  Open your Windows Start Menu, and then click Accessories.

	 1.	 From Accessories, open Notepad.

	 2.	 Type the following code into Notepad exactly as it appears here:

Note  If you prefer, you can skip this step and download the Products.xml file from the 
book’s companion website.

<?xml version=”1.0” encoding=“UTF-8”?> 
<products> 
 <product> 
    <productname>widget123</productname> 
    <productprice>$99.45</productprice> 
  </product> 
  <product> 
    <productname>widgetXYZ</productname> 
    <productprice>$11.99</productprice> 
  </product> 
</products>

	 3.	 Save the file to your Documents folder with the file name Products.xml. It is 
important to add the .xml extension; otherwise, Notepad will save it as a .txt file.

CLEAN UP  Close Notepad.

Adding Products.xml to the Form as a Data 
Connection

In the following exercise, you will add the products.xml file as a resource file data con-
nection to the Products form you created earlier in the chapter.
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SET UP  Open InfoPath Designer.

	 1.	 In InfoPath Designer, ensure that you still have the Products form open that you 
created earlier in the chapter. (You might need to open it from the location where 
you saved it on your desktop.)

	 2.	 On the ribbon, click the Data tab.

	 3.	 Select From Other Sources, and then select From XML File. 

	 4.	 Browse to your Documents folder, and then click the Products.xml file you cre-
ated in the first part of this exercise.

	 5.	 Click Next, click Next again, and then click Finish, leaving all pages in the wizard 
set at their defaults. Nothing obvious will change on your form yet, but you have 
added the Products.xml file as a data connection.

	 6.	 From the Fields task pane on the right side of your screen, click the drop-down 
arrow, and then choose Products (secondary). 

This represents the data connection to the XML file you just added. Your form now 
has two data connections: the default Main and your products connection.

Tip  If you don’t see the Fields task pane, you can open it by clicking the Show Fields 
button on the Data tab on the ribbon.
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	 7.	 Ensure that your cursor is positioned below the dashed line on your form in the 
design surface.

	 8.	 In the Fields pane, right-click product in the products data connection, and then 
in the shortcut menu that appears, select Repeating Table. 

This action adds the data from your Products.xml file to the form design surface as 
an InfoPath Repeating Table control.
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	 9.	 On the ribbon, click the Home, and then click Preview. Voilà! You have a form dis-
playing data from the XML file that you created in the last step.  
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Keep in mind that it’s generally not necessary to create an XML data connection file. 
InfoPath will do that work for you in most cases. We went through that process simply to 
give you a taste for what XML really looks like and to illustrate the ability InfoPath has 
to easily work with external data connection sources.

CLEAN UP  Close the preview, and then save your form template.

Using the Template to Create a Form Instance
In the following exercise, you will use the Products form template to create and save an 
instance of the form. This will help you distinguish the difference between a template 
and an .xml form instance that is based on the template.

SET UP  Ensure that InfoPath Designer is closed. Open your Documents folder where 
you saved the products.xsn form template.

	 1.	 Double-click the products.xsn file. 

An instance of your form opens, but you’re not in design mode. You’re in data input 
Filler mode, using the template you created.

	 2.	 Select a date from the date picker, and then click the Save button.

	 3.	 Save the form to your Documents folder with the default file name. 

Notice the default file format is .xml. You have now filled out and saved a new form 
instance based on your template. Cool! 

CLEAN UP  Close out of this instance of the form, and then exit InfoPath Filler.
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Exporting the Template
In the following exercise, you will export the template into its component files so that 
you can see what’s under the covers of an InfoPath .xsn template.

SET UP  Open InfoPath Designer.

	 1.	 Find the products.xsn template in your Documents folder, right-click it, and then 
in the shortcut menu, choose Design.

	 2.	 On the ribbon, click the File tab, and then click Publish.

	 3.	 Click Export Source Files.

	 4.	 Click Make New Folder.

	 5.	 Create a folder called export files, and then click OK.

	 6.	 Open your Documents folder, and navigate to the export files folder you just 
created.

Inside the export files folder you should see several files. Included among them are all 
the component files that InfoPath uses to give us a form template (.xsn). Notice that our 
Products.xml file is contained inside the .xsn template along with several critical .xsd and 
.xsl files that help define the layout and behavior of the actual form. For the purposes of 
this book, it is not important that you understand the details of how these foundational 
technologies work, but if you’re curious, an Internet search for “xsd” or “xsl” will turn up 
everything you need. 

CLEAN UP  Close InfoPath Designer.
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Key Points
●● The InfoPath 2010 user interface received a significant update to put it on par with 

the other Office applications.

●● InfoPath 2010 allows non-programmers to build powerful forms that are based on 
the XML standard.

●● InfoPath 2010 has two desktop components: the Designer and the Filler.

●● InfoPath can consume data from external data sources such as XML files.

●● InfoPath can take advantage of many of the SharePoint 2010 capabilities, such as 
workflows, lists, and reporting.

●● InfoPath .xsn files are “packages” of individual components that comprise a func-
tional form template.
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	 7	 Receiving Data 
from SharePoint 
Lists and Business 
Connectivity Services

In this chapter, you will learn how to:
✔	 Work with Microsoft SharePoint 2010 lists as data sources for your forms
✔	 Benefit from maintaining data connections in a centralized Data Connection Library 

in SharePoint 
✔	 Configure and use the External Item Picker control and Business Connectivity 

Services to add information from external systems to your forms

Practice Files  Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete 
the exercises in this chapter are in the Chapter 7 practice file folder. A complete list of 
practice files is provided in “Downloading the Practice Files and eBook,” on page xxvi.

Receive Data Connections
In Chapter 6, “Publishing and Submitting Form Data,” you learned about data connec-
tions for submitting Microsoft InfoPath forms to SharePoint. In this chapter, you will learn 
about using data connections for retrieving data from SharePoint lists. You will use stan-
dard SharePoint lists, and you will also work with the new External Item Picker control in 
your forms. The External Item Picker is used to select items from SharePoint’s Business 
Connectivity Services (BCS). BCS is used to connect a SharePoint list to an external data 
source such as a customer or product database. 
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In this chapter, we will focus primarily on SharePoint list data connections. Chapter 9, 
“Working with the SharePoint User Profile Web Service,” shows you how to use web ser-
vice data connections to query data from SharePoint. InfoPath offers more data source 
options, such as XML files and databases, but those are beyond the scope of this book, 
because we want to focus primarily on the core SharePoint scenarios.

The deep integration between InfoPath and SharePoint gives InfoPath the ability to use 
SharePoint 2010 lists as secondary data connections to easily retrieve data into form 
controls. For many forms, an obvious benefit of using a SharePoint list data connection 
is that the data already exists and is maintained in a SharePoint list. Therefore, the form 
can always pull in the most up-to-date information from SharePoint rather than trying 
to duplicate the same information within your form. Also, if the data is maintained in 
SharePoint, it will be much easier to allow business users to provide updates to the infor-
mation that your form consumes, without the need to actually modify the form.

Adding a SharePoint List Data Connection
In the following exercise, you will add a control on an existing form so that the form can 
receive information from a SharePoint list.

SET UP  In InfoPath Designer, in Design mode, open the form Flight Delay Form 
Post Exercise 4 from the practice files location. This is the same form you created in 
the last exercise of Chapter 3, “Form Design Basics: Working with InfoPath Layout, 
Controls, and Views.”

In the scenario behind this exercise, you have had a request to add another field of infor-
mation to the Flight Delay form to capture the name of the flight’s captain. One effective 
way to handle this requirement might be to add a SharePoint receive data connection 
because you already have a list of pilots’ names in SharePoint.

	 1.	 Publish the Flight Delay form to a form library in SharePoint (if it is not already).

	 2.	 Create a new SharePoint custom list in the same site. Call the list Pilot Names.
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	 3.	 In the list, create one text column named Pilot Name.

	 4.	 On the ribbon, on the List tab, click the List Settings button. Set the Require that 
this column contains information option of the Title column to No.

	 5.	 Enter the following seven pilot names in your list:
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	 6.	 Switch back to the Flight Delay form in InfoPath Designer. In the table on the top 
part of the form, right-click in the area below the Reason for Delay field.

	 7.	 In the label area, add the text Pilot Name, and then insert a Drop-Down List Box 
control. In the control’s properties, rename it PilotName.

	 8.	 On the ribbon, on the Data tab, click the From SharePoint List button to create a 
receive data connection on your form.

The Data Connection Wizard opens.

	 9.	 Provide the required information in the wizard to add the Pilot Names list you 
added in step 2. On the third page of the wizard, select the check box to add the 
Pilot Name field. 
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	 10.	 For the remainder of the wizard pages, accept the defaults, and then click Finish.

Now you need to connect the SharePoint list receive to the Drop-Down List Box 
control.

	 11.	 In the properties for the Pilot Name Drop-Down List Box control, select Get 
choices from an external data source and ensure that Pilot Names is selected, as 
shown in the following screenshot.

	 12.	 Click OK, and then press F5 to preview the form. 

You should now have the information from the SharePoint list available in your 
Pilot Name field.
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	 13.	 Use the Quick Publish button to update the form library with your new and 
improved form. 

Now, anytime a new pilot name is added in the SharePoint list, your form will auto-
matically display the name in the Drop-Down List Box control.

CLEAN UP  You can leave InfoPath Designer open if you intend to continue on to the 
next exercise. Otherwise, save your form and close InfoPath.

Note  For a more sophisticated example of consuming SharePoint lists in a form, read the blog 
article at http://www.wonderlaura.com/Lists/Posts/Post.aspx?ID=129, which describes how you 
can add multiple SharePoint list data connections in your form so that they connect and query 
one another.

Data Connection Libraries
Data connections from SharePoint lists generally work great in either InfoPath filler or 
browser forms. However, using data connections in browser-enabled InfoPath form 
templates introduces some potential management and authentication challenges that 
can be addressed by simply converting your data connections in InfoPath to Universal 
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Data Connection (UDC) files. UDC files abstract the data connection information from 
the form template and place the connection information in a special SharePoint library 
called a Data Connection Library (DCL), as shown in the following illustration.

InfoPath 2010 uses data connections that adhere to the UDC file type. They have either a 
.udcx or a .xml file extension. You can connect to various types of data sources with UDC 
files, which are stored on the SharePoint server and then used as data connections in 
your form templates. Using a UDC file in a Data Connection Library offers several poten-
tial benefits, including the following:

●● You can publish a form template that can access data sources in a different security 
domain (that is, another server). This is a very useful capability because browser 
form authentication can be very challenging when crossing security domains.

●● It will be easy for you to configure data connections that work in both the InfoPath 
Filler client and in InfoPath Forms Services.

●● You can easily modify the UDC file to redirect data connections to new or updated 
data sources without modifying all the forms that reference the UDC file. This is 
much easier than having to go back and update every form template.

●● Last but definitely not least, you can have a single place to publish data connec-
tions that can be shared across multiple forms and even multiple servers. Think of a 
common data source you might use in your business that might be useful in many 
different forms—perhaps a list of department names, job titles, store locations, and 
so on. It would be much easier to maintain the data connection and security set-
tings in one location for this type of information. All the forms in your business that 
need that information can reference one UDC. Combining a UDC file and a Data 
Connection Library is an excellent strategy for simplifying large or complex form 
environments.
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The process for adding a UDC is actually quite simple. First, you need to have a Data 
Connection Library set up in SharePoint. Assuming one is in place, you add your data 
connection in InfoPath as usual. In the Manage Data Connection dialog, you simply use 
the Convert To Connection File button, which will walk you through a wizard to convert 
and save your connection as a UDC file.

You will need to provide the location of the Data Connection Library in SharePoint. In 
the following screenshot, we are publishing the data connection as a UDC file named 
Pilots.udcx to a library named Pilot Information.

After you have done this, you can reuse the data connections in other new forms, by 
using the From SharePoint Server button on the ribbon’s Data tab. 



	 Data Connection Libraries    203

Next, browse for UDC files in Data Connection Libraries, and then pick the one you need 
for your new form.

Now your new form can use the data from the Pilots Name SharePoint list data con-
nection that you created in the previous exercise. However, it’s now stored in a centrally 
managed Data Connection Library, and all your forms that require this information can 
reference a single UDC file for their data.
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The External Item Picker and Business Connectivity 
Services

Many companies use BCS in SharePoint to connect to external systems such as customer 
or product databases and make that information available in SharePoint. BCS is different 
from the previous types of data connections we’ve discussed in one major way: the data 
resides in its own application rather than in a SharePoint list. BCS gives SharePoint (and 
thus InfoPath) a “view” into that data, but the data still resides natively in its own applica-
tion (typically a database). 

Fortunately, for situations in which your company is utilizing BCS in SharePoint 2010, 
InfoPath 2010 has a control called the External Item Picker that exists specifically for con-
suming data from BCS. When added to a form, this control provides an easy way for 
users to select items from the data source to which BCS is connecting. For example, per-
haps the user is filling out a customer service form, and you’d like her to select the cus-
tomer name directly from BCS rather than creating a duplicate list of that information in 
SharePoint and another data connection in your form. 

BCS is typically set up by a SharePoint administrator. Assuming that BCS is in place for 
you to utilize, the External Item Picker has several unique advantages for the InfoPath 
forms designer, including a pre-built security and data access model.

In the following exercise, you will follow the steps to add an External Item Picker control 
on to a form and set the control properties so that you can select an item from an ex-
ternal data source via the BCS. This exercise makes some assumptions about configura-
tion work that is already done on your system to set up an external content type (ECT) 
in BCS. The ECT uses XML to define data that is stored in an external system, such as a 
Microsoft SQL Server database. If you’re not the SharePoint administrator, you will need 
to work with that person to gather some information that is required—and perhaps 
provide some instructions about how you need the ECT configured to make it work with 
InfoPath.

SET UP  Open InfoPath Designer. 

	 1.	 Create a new blank form, and then publish it to a form library in SharePoint.

	 2.	 Add an External Item Picker control to your form.

	 3.	 Right-click the control, select the control properties, and then click the General tab.
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This page includes several properties that you will need to gather from your 
SharePoint System Administrator. The easiest way to collect these properties is by 
going to Manage Service Applications in Sharepoint 2010 Central Administra-
tion and choosing Business Data Connectivity Services.

	 4.	 Click the specific ECT to which you want to connect. The following screenshot, 
shows an ECT with the name Sales Order DB. 
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	 5.	 Gather the following information from the External Content Type Information 
page:

❍❍ Name

❍❍ Namespace

❍❍ External System

	 6.	 Switch back to InfoPath, with the properties of the External Item Picker control 
still open. Then do the following:

❍❍ Populate the ECT Namespace field with Namespace.

❍❍ Populate the ECT Name field with Name.

❍❍ Populate the System Instance Name with External System.

❍❍ Skip the Finder Name for now; you will add that data in a later step.

❍❍ Populate the Display Field Name with the actual database field that you’d 
like to use in the control. If your administrator used SharePoint Designer to 
create the ECT, you can easily go to the properties of the ECT in Designer and 
see all the available fields, as shown in the following screenshot. In this exam-
ple, it is Customer Contact.
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	 7.	 In the control properties dialog box, switch to the Other Settings tab. Ensure that 
the Refresh on Open check box is selected, and then switch the Picker Mode 
drop-down box at the bottom of the page to Connect to External Data Source 
through SharePoint. You need to set it that way because you are using BCS in 
SharePoint.
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	 8.	 Switch back to the General tab. 

You are almost finished, but to have your control work properly, one very impor-
tant field remains to be filled out: the Finder Name field. The Finder Name is 
equivalent to a filter on the ECT. This gives the user the ability to search for infor-
mation in the control. If you do not configure a filter, the user will be presented 
with a list of all results from the database, and he will have to scroll through them 
all rather than simply searching.

	 9.	 If your administrator has already defined a filter on the Read List operation of the 
ECT, add the filter name to the Finder Name field in the External Item Picker 
Controls Properties dialog box. In this example, the filter name is simply Filter.

Note  If you do not have a filter on the ECT, see the instructions that follow this exercise 
for instructions on how to add a filter, and then return to step 9.

	 10.	 Click Apply, and then OK. 

You should be back on your form design surface. Use the Quick Publish button to 
update the form library with your new form. If you go to the form library and 
create a new form instance, you should be able to use the External Item Picker 
control to browse and search for data from the external system. 
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Tip  Do not be discouraged if this control doesn’t work properly on your first, second, third, or 
even tenth attempt. It is one of the most complex InfoPath controls. Several moving parts need 
to be set just right in SharePoint and InfoPath to make the External Item Picker work properly. 
Verify that you have entered everything accurately at every possible point along the way.

CLEAN UP  Save your form, and then close InfoPath Designer.

Adding a Filter to a Business Connectivity External 
Content Type

Part of the reason the External Item Picker control is so daunting for new forms design-
ers is that it requires knowing exactly which information from the ECT in SharePoint must 
be added to the control properties so that everything works correctly. That information 
was covered in the previous exercise. In most cases, an ECT will be created either in 
Microsoft Visual Studio or SharePoint Designer 2010. In either case, the developer or ad-
ministrator should be able to give you the necessary data. However, to make the External 
Item Picker work as intended, the one extra step that you might need to ask them to 
take is to add a wildcard filter so that your users can search for the information. The filter 
must be added in a very specific manner for it to work properly. The screenshots included 
in the following exercise are from an ECT that has been set up in SharePoint Designer. 
The instructions will provide the steps necessary for you or your SharePoint administrator 
to add the filter to new or existing ECTs.

SET UP  Open the SharePoint site you want to work with in SharePoint Designer. 

	 1.	 Select the appropriate ECT; in this case, it is Sales Order DB.
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	 2.	 In the External Content Type Operations dialog box, double-click Read List to 
open the Read List Operation Properties Wizard.

	 3.	 On the Filter Parameters page of the wizard, set your configuration as shown in 
the following illustration. 

The name of the filter will be the same name that you use to populate the Finder 
Name field in the External Item Picker properties in InfoPath. The Data Source 
Element and Filter field should be set to the same field from the database as the 
one you want the picker control in InfoPath to display.

	 4.	 On the Return Parameter page, ensure that you have selected the appropriate 
Data Source Element option and that the Show In Picker check box is selected.
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	 5.	 When you’ve completed the Read List Operation Properties Wizard, save your 
changes in SharePoint Designer. This will update the ECT properties in BCS and 
allow your form to filter on the data source.

CLEAN UP  Save your form, and then close SharePoint Designer.

Key Points
●● InfoPath 2010 provides very tight integration with data in SharePoint lists.

●● SharePoint lists are easily maintainable by business users and are thus a great way 
to ensure that the data in your forms is current.

●● Data Connection Libraries make the administration of data sources much easier by 
centralizing security and management.

●● By using the External Item Picker control, InfoPath can consume data from external 
systems through SharePoint 2010 BCS.
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Font Styles section (Home tab)  262
form approval process

about  285
approval fields  288–293
approval sections  301–306
custom actions  270–273
emails in  261, 325–332
form load rules  297–301
form views and  287–288
gathering requirements for  286–287
reimbursement form example  287
status fields  293–297
Submit button actions  306–318
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merging  407–411
with multiple views  140–150, 287–288
offline  39, 414–417
previewing  125, 418–419
primary types of logic  118–121
procurement form example  12, 121–126
products.xml file example  18–22
relinking  411
saving  176
setting default values with functions  126–129
working with sections and conditional 

formatting  134–140
Form Status field  293–297
form templates

about  28–34
administrator-approved  40–42, 154, 188–191, 214, 

337–338
creating form instance  22
custom list  86
editing  183
exporting  23
file extension for  13
IPFS support  335
naming conventions  29
pre-built  30–34
quiescing  338
Request Title field  122
SharePoint supported  30
UDC files and  201

Form Templates document library  179
formulas

inserting into forms  120
quotations around text  130

Form Web Parts button (List tab)  110
From Other Sources button (Data tab)  19
From SharePoint List button (Data tab)  198
From SharePoint Server button (Data tab)  202
From SOAP Web Service button (Data tab)  240
Full Control permission level  254, 368
Function button  313, 322
functions. See also specific functions

advanced  423–426
components of  121
defined  95
postbacks and  350
return values for  121
setting default values with  126–129
types of  120–121

Function setting  164

form load process  342–346, 350
form load rules

adding action steps  243–246
default values and  296
in approval process  297–301

Form Options button (Backstage)  9
Form Options dialog box

email attachments and  418
E-Mail Attachments section  416
merging forms  411
modifying button functionality  412–413
Preview section  418–419

Form Options window
accessing  112
Advanced tab  113
Compatibility tab  113
Filler Features tab  113, 176
Offline tab  113
Property Promotion section  163
Versioning tab  113
Web Browser tab  113

form parameters
about  39
additional concepts  231–232
defined  225
Web Part connection example  225–231
website feedback form example  225–231
workflow initiation forms  256, 266–270

form requirements
data considerations  34–35
decision-making process for  47–48
Design Checker and  42–46
factors to consider  36–42
receiving forms  35
SharePoint versions and  35–36
submitting forms  34
template considerations  28–34
view considerations  46

forms. See also browser-based forms; client-based 
(filler) forms; specific form examples

adding formatting to  6, 130–133
adding logic to  6, 285
adding rules to  130–133, 135–138, 141, 143
connecting to web services  238–241
creating  4, 13, 28
creating load rules  241–246
customizing default  5
defined  87
hiding sections in  146–147
inserting buttons into  222
inserting formulas into  120
inserting pre-built layouts to  8
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I
Indicator dialog box  392
Industrial Vantage theme  56
InfoPath

benefits of using  2–4
functionality  11–13
new features  4–11
XML support  16–17

InfoPath 2007 - Blank 2007 Form (InfoPath Filler) 
template  33

InfoPath 2007 - Blank 2007 Form template  33
InfoPath Designer. See also Field pane; Rules pane

about  4, 34
adding products.xml file to forms  19–22
Controls pane  59, 67
exercise creating forms  13–15
gridlines in  53
opening  13, 155
Themes area  56

InfoPath Filler
about  4, 34
controls available via  59
merging forms  411
offline forms and  414
postbacks and  349

InfoPath Filler Form  30
InfoPath Forms Services (IPFS)

about  335–336
browser-based forms  29
configuration settings  336–340
double-hop problem  340
minimizing postbacks  349–351
monitoring form load process  342–346
monitoring forms with attachments  346–349
monitoring postbacks  351–353
performance factors  341–342
publishing forms  12
SharePoint Central Administration and  336–340

InfoPath Form Web Part
about  109–110, 213
adding connections between Web Parts  224
configuring settings  214–223, 224
parameters and  39, 225–231
testing form  222–223

InfoPath views
about  77, 86
adding  78–81
common situations for  78–81
creating for Web Parts  215
form requirements and  46
forms with multiple  140–150, 287–288, 350
list form limitations  111
modifying settings  46
postbacks and  350

G
gathering requirements for approval 

process  286–287
Get Data From setting (Web Parts)  224
Get Form From setting (Web Parts)  224
GetUserProfileByName data connection

modifying  297
querying  242
refreshing control connection  249
selecting  240, 242

GetUserProfileByName method  236

H
help desk application example

alerts based on views  368–369
Content Query Web Parts  387–390
creating SharePoint sites  356–360
creating SharePoint views  362–366
customizing priority column appearance  376–381
dashboards based on form libraries  386
filter Web Parts  371–375
KPI Web Parts  390–397
library Web Parts  370–371
new form button  381–386
publishing forms  357–360
rating items  366–368
Translate function  425

hidden fields  294–297
hierarchical information structure  36
Home tab (ribbon)

Button object  222
Controls list  97, 101
Font Styles section  262
Format Text area  72, 75
New Items button  416
Preview button  53, 418

HTML
performance factors  341, 346
viewing with Fiddler  345

HTML button (Format Text tab)  384
HTTP standard

Fiddler tool support  342
postbacks and  349
web services and  235

Hyperlink control
about  61, 62
adding  73
mapping column types to  99

Hyperlink Or Picture column type  86, 99
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K
KPIs (Key Performance Indicators)

about  386
KPI Web Parts  390–397
ratings as  368

KPI Web Parts  390–397

L
labels, positioning in controls  93
layouts

adding  54–58
design considerations  52–54
list forms  92–97

Layout tab (ribbon)
Cell Padding button  58
Insert Above button  226
Insert Below button  94, 101
layout tools and  53
Shading button  57–58
Width button  217

library columns  163
Library Settings button (Library tab)  367
Library tab (ribbon)

Alert Me button  368
Create View button  364, 365, 393
Current View drop-down box  412
Library Settings button  367
Workflow Settings button  330

library Web Parts  370–371
List Box control

about  60
mapping column types to  98

list forms (SharePoint)
additional information  200
calculated fields in  103–108
choosing  34
customizing  5, 87–91
external  280–281
fields in  97–102, 196–200
layout of  92–97
limitations of  30, 36, 110–112
offline  39, 416
options screen  112–113
parameter considerations  225
repeating tables and  36–37
travel request example  87–91
Web Part pages and  109–110

List Or Library setting (Web Parts)  214
Lists And Libraries section (SharePoint 

Designer)  281–282

read-only  317
security considerations  286
switching  142, 350

Info tab (Backstage view)  8
Initiation Form Parameters button  266
initiation forms (workflow)

about  254–256
adding conditions to  263–266
automatic start option  255
creating approval workflow  256–261
customzing  262–264
manual start option  254, 255, 262
parameters in  256, 266–270

input controls, types of  59–61
Insert Above button (Layout tab)  226
Insert Below button (Layout tab)  94, 101
Insert Calculated Value dialog box  107
Insert Field or Group button  107, 243
Insert Formula dialog box

about  120
concat function example  128, 173
insert field link  424
Insert Function button  95

Insert Function dialog box
All category  173
Date and Time category  95, 128, 157
Date category  69
userName function  308–309

Insert Picture Control dialog box  239, 346
Insert tab (ribbon)

Clip Art button  377
layout tools and  53
More button  58

installing Fiddler tool  342–346
instances (form)

creating  22
maximum size  339

IPFS (InfoPath Forms Services)
about  335–336
browser-based forms  29
configuration settings  336–340
double-hop problem  340
minimizing postbacks  349–351
monitoring form load process  342–346
monitoring forms with attachments  346–349
performance factors  341–342
publishing forms  12
SharePoint Central Administration and  336–340

items
defined  86
rating  366–368
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Microsoft Office ribbon. See also specific buttons 
and tab

about  4
changing width of  xxi
dynamic elements  xix–xx

Microsoft Office SharePoint Server (MOSS)  28
Microsoft SharePoint Foundation

form requirements and  35
Sandboxed Code Service  42

modal pop-up boxes  109
monitoring

form load process  342–346, 350
forms with attachments  346–349
postbacks  351–353

More button (Insert tab)  58
MOSS (Microsoft Office SharePoint Server)  28
Multiple Lines Of Text column type  86, 98
Multiple-Selection List Box control  98
multiple views

about  287–288
postbacks and  350
wizard-style forms with  140–150

My Documents view  362

N
naming conventions

best practices for fields  99
templates and data connections  29

network traffic analysis  341–342
New button  307
NewForm.aspx file  110
New Form rule  319
New Items button (Home tab)  416
New tab (Backstage view)  9
Notepad (Microsoft)  17
notification emails  369
now function

about  129
dateTime field and  157
setting default values  126
Translate function and  426

NT login  374
Number column type  86, 98
Numbered List control  61

List Settings button (List tab)  88, 197
lists (SharePoint)

adding data connections  196–200
best practice  370
control support in  97
creating workflows for  254
form libraries as  2
fundamental components  86
versioning setting  86
viewing in SharePoint Workspace  417
Web Part settings  214

List tab (ribbon)
Create Column button  101
Customize Form button  92, 101
Customize Tab option  101
Form Web Parts button  110
List Settings button  88, 197
Sync To SharePoint Workspace button  417

List URL dialog box  394
logic

adding to forms  6, 285
examining with Rule Inspector  402–407

Lookup column type  86, 98
Lookup for Person or Group dialog box  260–261

M
magnification, screen display  xxii
Main data source  65, 243
Manage Data Connection dialog box  202–203
Manage data connection files setting  339
Managed Metadata column type  86, 99
Manage form templates link  337, 339
Manage Form Templates page  338
Manage List permission  254–255
Manage Rules button (Control Tools tab)  123, 130, 

134
Manage User Properties page  237
mapping column types to controls  98
Merge Documents view  407
Merge Settings button  408, 409
Merge Settings dialog box  409
merging forms  407–411
metadata, defined  32
metrics, ratings as  368
Microsoft InfoPath

benefits of using  2–4
functionality  11–13
new features  4–11
XML support  16–17

Microsoft Office Fluent interface  4
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minimizing postbacks  349–351
monitoring IPFS form load process  342–346
monitoring products form  346–349

permission levels
creating custom  255
workflows and  287, 270, 254–256

Person/Group Picker control
about  61
event registration form example  247–251
mapping column types to  98

Person Or Group column type  86, 98
Picture Button control

about  62
in provisioning request example  142–144
rules support with  141

Picture Button Properties dialog box  149
Picture control

about  61, 62
connecting fields to web services  241
event registration form example  239
monitoring  products form with  346–349

placeholder text  38
Plain List control  61
points per inch (ppi)  xxii
Policies library

about  257
accessing workflows  261–262
adding custom actions to  271–273
security considerations  270

Policy Approval Workflow button  273
policy approval workflow example

adding conditions to  263–266
adding parameters to  266–270
creating  256–261
customizing  262–264
editing workflow  276–277

pop-up boxes, modal  109
postbacks

analzying  338
browser-based forms and  338, 349–351
defined  349
monitoring  351–353
performance factors  341

ppi (points per inch)  xxii
Preview button (Home tab)  53, 418
previewing forms  125, 418–419
print preview  10
Print tab (Backstage view)  10
procurement form example

adding action and formatting rules  130–133
creating forms with multiple views  140–150
setting default values with functions  126–129
working with sections and conditional 

formatting  134–140
working with validation and formatting  121–126

O
object controls

about  59, 61
list forms and  99
types of  61–62

Office ribbon. See also specific buttons and tabs
about  4
changing width of  xxi
dynamic elements  xix–xx

offline forms
design considerations  39–40
options available for  414–417
in Outlook  416
SharePoint list forms and  416

Offline tab (Form Options window)  113
OneNote  402
Optional Section control  63
Option Button Binding dialog box  313
Option Button control

about  60
mapping column types to  98

option buttons  111
Options tab (ribbon)  379
Other category  423
Outlook, offline forms in  416

P
Page Design tab (ribbon)

about  8
layout tools and  53
managing views  46, 78
Page Layout Templates button  93
Properties button  80
Themes section  , 56, 262
View drop-down box  405
View Request option  134

page layouts, inserting pre-built  8
Page Layout Templates button (Page Design 

tab)  93
Page tab (ribbon)  375
parameters (form)

about  39
additional concepts  231–232
defined  225
Web Part connection example  225–231
website feedback form example  225–231
workflow initiation forms  256, 266–270

Paste Rule button  305
pending changes to workflows  277
performance factors

commonly seen  341–342
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Q
queries

GetUserProfileByName method  242
offline forms and  414
User Profile web service  242

Query For Data action  119
query string parameters  232
Query String (URL) Filter Web Part  230
question mark (?)  381
Quick Publish button (File tab)  90, 263
Quick Rules button. See Add Rule button (Control 

Tools tab)
quotations around text  130, 244

R
rating items  366–368
Read List Operation Properties Wizard  210–211
Read-Only property  127, 159
read-only view  317
Read permissions  270
receiving data

adding filters to content types  209–211
adding list data connection  196–200
additional information  200
Business Connectivity Services and  204–209
Data Connection Libraries and  200–203
External Item Picker control and  204–209
form requirements  35
from data connections  195–196

Recent tab (Backstage view)  9
records, defined  86
reimbursement form example

about  287
approval fields  288–293
approval sections  301–306
creating default values for rows  419–423
emails in approval process  325–332
examining with Rule Inspector  402–407
form load rules  297–301
form views  287–288
status fields  293–297
Submit button actions  306–318
workflow approvers  318–324

relinking forms  411
Repeating Section control

about  36, 63
list form support  97

products.xml file
200 HTTP HTML event  344
adding to forms  18–22
creating  18

program window, resizing  xxi
promoting fields to columns  163–168
properties

setting for controls  64
views and  77

Properties button (Page Design tab)  80
Properties (Control Tools) tab

about  64
Change Binding button (Properties tab)  64
Control Properties button  , 217, 44
Edit Choices button  70
Shading box  96

Properties dialog boxes
Accessibility  378
Button  349
Calculated Value  105
Calculated Values  313
Drop-Down List Box  , 199
External Item Picker  204–209
Field or Group  96, 106–107, 157
Picture Button  149
Repeating Table  408
Text Box  44, 127, 217–218

Property Promotion screen  219, 225
provider Web Part  371
Publish button (File tab)  358, 330
publishing forms

about  12
as administrator-approved templates  154, 

188–191
to content type  154, 178–188
to form library  154
help desk application example  357–360
IPFS support  335
methods for  154
security settings and  41
time-off request form example  154–162

Publishing Wizard
help desk application example  358–359
promoting columns via  163–168
publishing forms as administrator-approved 

templates  189–191
publishing forms to content type  180
time-off request form example  160–162
Web Part connection parameters  225, 226–231

Publish tab (Backstage view)  10
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Rules pane
about  6–7
Add button  309
adding action rules via  143
copying rules  139
event registration form example  242–246, 247–248
Hide this control check box  136
New button  307
opening  123, 134
Paste Rule button  305
reimbursement form example  298
Shading Color tool  124, 130

run time
adding controls at  61
defined  53

S
Save As button, disabling  176–178, 413
Save button

disabling  176–178, 413
removing  413

screen display
density of  xxi
magnification and  xxii
screen resolution and  xxi

screen resolution  xxi
ScreenTips

Cannot be blank when you hover over the 
field  125

in provisioning requests example  149
scripting, Windows PowerShell  336
Scrolling Region control  44
Section Binding dialog box  312
Section control  62, 63
sections

approval  301–306, 311–317
binding controls to  312
conditional formatting and  134–140
hiding in forms  146–147

security
administrator-approved templates and  41
email attachments and  417
user roles and  77
workflows and  254–256, 270, 286

Select a Field or Group dialog box
event registration form example  243–244, 

248–249
modifying workflows  278
procurement form example  135
reimbursement form example  296, 308

Select Picture screen  383
Select The Form View To Display By Default setting 

(Web Parts)  215

Repeating Table control
about  36, 62, 63
adding  20, 71
container controls and  59
design factors to consider  36
list form support  97

Repeating Table Properties dialog box  408
requirement gathering for approval 

process  286–287
resizing program window  xxi
REST (Representational State Transfer)  235
return values (functions)  121
Reusable Workflow button  325
ribbon. See also specific buttons and tabs

about  4
changing width of  xxi
dynamic elements  xix–xx

Rich Text Box control
about  60
mapping column types to  98

roles (user)
form design considerations  37
forms and  419
views and  77

Rule Details dialog box
Data Connection field  187
even registration form example  242–243
Field button  132
field picker button  308
provisioning requests form  144

Rule Inspector button (Data tab)  402, 403
Rule Inspector dialog box  403
Rule Inspector tool  402–407
rules

about  6
action  118–119, 130–133, 141, 143, 242–246, 248, 

307–311
adding to forms  130–133
adding to workflows  285
conditional formatting  119
copying  139, 305
creating forms with multiple views  140–150
creating to load forms  241–246
data validation  118
formatting  130, 135–138, 147, 304
form load rules  241–246, 295, 296
hiding sections of forms  146–147
reimbursement form example  302–306
Rule Inspector tool  402–407
Rules pane and  6
submitting forms with  75
switching views with  142
validation and formatting example  122–126

Rules button  305
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limitations of  30, 36, 110–112
offline  39, 416
options screen  112–113
parameter considerations  225
repeating tables and  36–37
travel request example  87–91
Web Part pages and  109–110

SharePoint lists
adding data connections  196–200
best practice  370
control support in  97
creating workflows for  254
form libraries as  2
fundamental components  86
versioning setting  86
viewing in SharePoint Workspace  417
Web Part settings  214

SharePoint List template  30
SharePoint Online with Office 365

custom code in  42
form requirements and  35
sandboxed solutions  42

SharePoint program folder  337
SharePoint Server platform

form requirements and  35
IPFS support  336

SharePoint Server Publishing feature  356
SharePoint sites

creating  356–360
wireframes and  386

SharePoint User Profile web service
about  235–237
adding people picker to event registration 

form  247–251
adding Submit button to event registration 

form  247–251
building event registration form  238–241
connecting controls to  242
connecting fields to  241–246
connecting forms to  238–241
creating load form rules  241–246
creating rules on event registration form  241–246
querying  242

SharePoint views
about  361–362
additional information  361
alerts based on  368–369
creating  362–366, 370–371
customizing  376–381
filtered  361, 368–369, 372
Merge Documents view  407

SharePoint Workspace  417–418
Show Fields button (Data tab)  19, 321
Show InfoPath Ribbon Or Toolbar setting (Web 

Parts)  215

Select Users dialog box  260
Send Data To Connected Web Parts When Page 

Loads setting (Web Parts)  215
Send Data To setting (Web Parts)  224
Send Data To Web Part action  119
Set A Field’s Value action  119
shading, applying  57–58
Shading button (Layout tab)  57–58
Shading Color tool (Rules pane)  124, 130
SharePoint

BCS support  3
version considerations  35–36

SharePoint Central Administration  336–340
SharePoint dashboards

based on form libraries  386
Content Query Web Parts and  387–390

SharePoint Designer
about  253
Advanced Mode button  376
cautions using  376
custom actions  270–273
external list forms  280–281
Lists And Libraries section  281–282
workflow basics  253–254
workflow initiation forms  254–256
Workflow Settings tab  269
workflow task forms  274–280

SharePoint form library
All Documents view  362
dashboards based on  386
Merge Documents view  407
My Documents view  362
pre-built templates and  31–33
publishing to  154
setting considerations  46
as SharePoint lists  2
submitting forms to  168–178, 184–188
versioning setting  86
Web Part settings  214, 224

SharePoint Form Library template  30
SharePoint Form Services

about  4
enhanced support for  6

SharePoint Foundation
form requirements and  35
Sandboxed Code Service  42

SharePoint Library Submit connection  297
SharePoint list forms

additional information  200
calculated fields in  103–108
choosing  34
customizing  5, 87–91
external  280–281
fields in  97–102, 196–200
layout of  92–97
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templates
about  28–34
administrator-approved  40–42, 154, 188–191, 214, 

337–338
creating form instance  22
custom list  86
editing  183
exporting  23
file extension for  13
IPFS support  335
naming conventions  29
pre-built  30–34
quiescing  338
Request Title field  122
SharePoint supported  30
UDC files and  201

testing Web Parts  222–223
text

placeholder  38
quotations around  130, 244

Text Box control
about  60
form design considerations  38
mapping column types to  98
positioning labels  93

Text Box Properties dialog box
Data tab  44, 127
Display tab  44, 127, 217–218

themes
applying  56–58
selecting for list forms  93

Themes section (Page Design tab)  , 56, 262
time-off request form example

creating  154–158
promoting fields to columns  165–168
publishing as administrator-approved 

template  189–191
publishing to content types  179–188
publishing to form library  159–162

today function  157, 309
Translate function  423–426
travel request example

adding calculated columns  103–108
adding list form fields  101–102
creating list forms  87–91
customizing list form layouts  92–97
list form limitations  111–112

troubleshooting
file location  419
tools supporting  402–407

Simple Object Access Protocol (SOAP)  235, 238
Single Line Of Text column type  86, 98
Site Assets library  383
Site Collection Features page  338
Site Column Group setting  164
site columns  163
SOAP (Simple Object Access Protocol)  235, 238
source parameter (forms)  231
Specify Filter Conditions dialog box  244
spell checker  38
Start Options (workflow settings)  254–256
stateless protocols  340, 349
status fields  364, 293–297
Status List Web Part  396
Stop Editing button (Page tab)  375
String Builder dialog box  326
Submit Behavior setting (Web Parts)  215
Submit button

about  413
actions in approval process  306–318
event registration form example  247–251

Submit Data action  119
Submit Options button (Data tab)  186, 220
Submit Options dialog box  220–221
submitting forms

to databases  38
to form library  168–178, 184–188
form requirements  34
with rules  75

Switch Views action  119
Sync To SharePoint Workspace button (List 

tab)  417

T
Table Drawing tool  53
Table Layout tab  4
tables

adding  54–58
deleting  92
dragging controls into  93
dragging fields into  94
laying out  53
repeating  36–37, 59

Table Tools tab. See Layout tab (ribbon)
task actions  274–275
task forms (workflow)

about  274–276
modifying  277–280
Task Process Designer  260, 276–278

Task Process Designer  260, 274–276
Template Part - Blank (InfoPath Filler) template  34
Template Part - Blank template  34
Template Part - XML or Schema template  34
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creating for Web Parts  215
form requirements and  46
forms with multiple  140–150, 287–288, 350
list form limitations  111
modifying settings  46
postbacks and  350
read-only  317
security considerations  286
switching  142, 350

views (SharePoint)
about  361–362
additional information  361
alerts based on  368–369
creating  362–366, 370–371
customizing  376–381
filtered  361, 368–369, 372
Merge Documents view  407

VSTA (Visual Studio Tools for Applications )  42

W
Web Browser Form  30
Web Browser tab (Form Options window)  113
Web Parts. See also specific Web Parts

about  109–110
adding connections between  224
best practice  370
configuring settings  214–223, 224
creating custom  213
creating views for  215
filter  371–375
library  370–371
parameters and  39, 225–231
testing  222–223

Web Part settings
Content Type option  214
Display A Read-Only Form (Lists Only) option  215
Get Data From option  224
Get Form From option  224
List Or Library option  214
Select The Form View To Display By Default 

option  215
Send Data To Connected Web Parts When Page 

Loads option  215
Send Data To option  224
Show InfoPath Ribbon Or Toolbar option  215
Submit Behavior option  215

web proxy service  340
Web Service Proxy page  339
web services

about  235–237
adding people picker to event registration 

form  247–251

U
UDC files  200–203, 340
UDCX files  201
UDDI (Universal Description, Discovery and 

Integration)  235
Update Fields message  269
Upload form template link  339
URL dissection parameter (form)  232
user interface

about  12
workflow approval process and  287

userName function  308–309, 332
User name property  374
User Profile database (SharePoint)  236–237
User Profile web service

about  235–237
adding data connections to  240
adding people picker to event registration 

form  247–251
adding Submit button to event registration 

form  247–251
building event registration form  238–241
connecting controls to  242
connecting fields to  241–246
connecting forms to  238–241
creating load form rules  241–246
creating rules on event registration form  241–246
querying  242

user roles
form design considerations  37
forms and  419
views and  77

User Session settings  339

V
validation

adding  7
procurement form example  121–126
Rules pane and  6

variables
creating  326
defined  268

versioning  86
Versioning tab (Form Options window)  113
View drop-down box (Page Design tab)  405
View Request option (Page Design tab)  134
Views button  413
views (InfoPath)

about  77, 86
adding  78–81
common situations for  77
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alerts and  369
automatic start option  255
conditions and  254, 263–266
considerations promoting columns  163
custom actions  270–273
email settings  261
manual start option  254, 255, 262
pending changes  277
permission levels and  254–256, 270, 287
security considerations  254–256, 270, 286
sending email via  417
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